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北京数字绿土科技股份有限公司，2012年9月成立，总部位于北京市中关村软件
园，是一家由海归专家团队创办的高新技术企业，目前已在美国、武汉、深圳、广州、
广西、成都等地设立分公司。公司自主研发的硬件系统，如机载、车载、背包等多平台
激光雷达扫描设备，以及点云和影像处理软件系统，如LiDAR360激光雷达点云数据
处理平台等，被广泛应用于数字城市、智慧电力、地理信息、智慧农林、无人驾驶、高
精度地图等专业领域。
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    Headquartered in Berkeley, California, GVI is a leading innovator of 3D 
mapping technologies. We provide a wide range of advanced aerial, 
terrestrial, and mobile LiDAR surveying and mapping hardware systems, 
as well as cutting-edge software and service solutions. By partnering with 
the industry’s most innovative companies, such as Reigl, Velodyne, and 
DJI Livox, we strive to bring to our customers the most effective products 
that will get the job done.
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Thank you for reading the "LiBase GNSS Receiver Quick Start Manual" by 
GreenValley International. This manual mainly describes the receiver's 
product functions, software operations, precautions and solutions to 
common faults.

Technical Support

User Notice

Complaints and Suggestions

From the date of purchase of LiBase products, users will enjoy the technical 
services and upgrade policies provided by GreenValley International inc.
       Headquarter address: 
       2120 University Ave, Berkeley 94704, California, USA
       Telephone：+1(510)345-2899
       Email：info@greenvalleyintl.com
       Website：www.greenvalleyintl.com，
Users can learn about the latest developments of GreenValley Internation-
als products and download technical information about the products on 
the website.

Regarding any suggestions and complaints regarding this manual or prod-
ucts, please contact our service hotline or one of our technical support team 
at info@greenvalleyintl.com.

·Before using this product, please read all the provided user information 
carefully to understand the usage and precautions of this product.
·In the process of outdoor installation of GNSS equipment, the GNSS host 
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Familiarity with the functions of the buttons on the receiver panel and the 
meanings of the indicator lights are of great help for the correct use of the 
equipment and can greatly improve the efficiency of project implementa-
tion.

LiBase GNSS Receiver

1.1 Receiver Details

③ Display panel

① Differential light

② Satellite light

In RTK mode, the differential data is sent and received, 
and the orange differential signal light flashes once per 
second.

flashing quickly when searching for satellites; when N 
satellites are found, the green LED light flashes N times 
every 5 seconds;

First page:
The left side of the first row displays the receiver status, 
and the receiver is configured through the panel or the 
handbook, and the receiver displays the status; the right 
side of the first row displays the WIFI and 4G status; WIFI 
off/on, 4G signal strength;

Part Indication/Function

should pay attention to waterproof treatment, and the GNSS receiver must 
be placed in the outdoor open-air and open environment when using or 
testing.
·Be careful not to drop the product on the ground or take any strong direct 
shocks.
·Do not plug or unplug any connecting cables such as serial ports when the 
power is turned on.
·Please connect your device strictly according to the requirements stated in 
the manual. For cables such as seven-core data cables, you need to pinch 
the root of the plug and gently plug it in and pull it out.
·When supplying power to this product (system), pay attention to the power 
supply requirements of the equipment.
·The transmitting station may overheat during long periods of usage. Please 
be careful to avoid burns. In addition, you must avoid or reduce unneces-
sary coverings on the surface of the station, and maintain a good ventilation 
environment.
·When using the transmitting station for a long time, personnel should keep 
a distance of more than 2 meters from the transmitting antenna to avoid 
radiation.
·When the antenna is installed outdoors, users should take appropriate 
lightning protection measures to prevent lightning strikes.
·Please do not continue to use the connected cables after they are dam-
aged. Please purchase and replace the new cables in time to avoid unneces-
sary damage and affect the use effect.
·If the equipment is damaged due to force (lightning strike, high voltage, 
collision), it no longer belongs to the scope of our company's free mainte-
nance policies.
·Please do not disassemble the casing of this product by yourself, other-
wise, the warranty will not be granted. 

Introduction
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Connect the handbook to the rover receiver, click (Rover), select the 
default: radio receiver differential, and enable.

2

Connect the handbook to the LiBase receiver, click (Base Station), select 
default: use the built-in radio to start the base station, enable, after the 
base station is successfully enabled, the status is displayed as the base 
station.

1

2.1 Receiver Connection

2.2 Mode Settings

2.2.1 Built-in Radio Mode

(Device) → (Connect Device) → (Target Device), start searching for the target 
device, select the device to be connected, and connect the device success-
fully.

The frequency set in the default mode is 460.050MHz. If there is no other 

Receiver Connection and Mode Settings 02

③ Display panel

④ Function key

⑤ Power button

The second line shows the number of satellites, the left is 
the number of satellites involved in the current workflow, 
and the right is the number of tracking satellites;
The left side of the third row displays the PDOP satellite 
position accuracy value, the right side displays the DC 
power supply icon, and the icon does not display if there 
is no DC power supply;
The fourth line shows the battery status of battery A and 
battery B;
The second page:
When configuring the receiver through the panel or 
configuring the receiver in different modes, the data link, 
communication protocol, mode, and frequency display 
status;
page three:
Smart base station, radio configuration, clear memory, 
static switching, WIFI control, language selection, power-on 
auto-start configuration, restore factory settings and exit 
settings and other functions.

Press the FN key to perform the page-turning operation of 
the LED display panel.

Press this button to switch on or off the machine or to 
confirm a function;
Press this button to turn on the power in the off state, all 
the lights will be on, and they will turn off after the 
self-test is completed;
In the power-on state, press and hold this button for 4 
seconds to turn off, the display indicates "shutdown", and 
the buzzer continues to sound.

Part Indication/Function

01Product Introductions
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Receiver Connection and Mode Settings 02
The frequency set in the default mode is 460.050MHz. If you need to modify 
the transmission frequency of the external radio, you can change it on the 
external radio. After modification, the mobile station selects the corre-
sponding channel to receive the difference.
CDL plug-in radio "channel-frequency comparison table"

2.2.3 Host Network Mode

Connect the handbook to the rover receiver, click (Rover), select the 
default: receiver network service difference, enable, and the base 
station name fills in the SN number of the base station receiver.

2

Connect the handbook to the LiBase receiver, click (Base Station), select 
Default: Receiver network service difference, enable, after the base 
station is successfully enabled, the status is displayed as the base 
station.

1

Custom

Channel

Custom 5

6

7

8

9

1 455.05

456.05

457.05

458.05

459.05

460.05

461.05

462.05

463.05

2

3

4

Frequency(MHz)Frequency(MHz) Channel

Connect the handbook to the rover receiver, click (Rover), select the 
default: radio receiver differential, and enable.

2

Connect the handbook to the LiBase receiver, click (Base Station), select 
default: use an external radio to start the base station, enable, after the 
base station is successfully activated, the status is displayed as the base 
station.

1

2.2.2 External Radio Mode

base station around to use this frequency, you can choose the above short-
cut operation.
If you want to change the frequency of the base station for transmission, 
select (Add) in the lower-left corner to add the mode, and set the built-in 
radio mode parameters by modifying the channel. After the setting is com-
pleted, (Save), customize the mode name, and click (Enable). It should be 
noted that the mobile station also needs to add the corresponding startup 
mode, and the parameter settings such as the protocol frequency must be 
consistent with the base station.
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03New Project

04Functional Usage

4.1 Parameter Calculation

(Project) → (Project Management), click the "+" below to create, enter the 
project name → select the coordinate system, obtain or enter the local 
central meridian in the projection, and confirm.

Under normal working conditions, it is necessary to select control points in 
the measurement area for parameter calculation and coordinate system 
parameter conversion and then perform measurement operations.

The following are the control point requirements for parameter calculation:

The control points are generally required to be at least 3, and they are 
evenly distributed inside the survey area;

1

The transverse Mercator projection is the Gauss-Krüger projection, and the 
universal transverse Mercator projection is the UTM projection.

The host network mode (network 1+1 mode) requires a built-in SIM card, the 
default IP address is 211.144.120.104, the port is 8888, the source list is the 
receiver SN number (such as XXXXXXXX), and the APN is CMNET.

Connect the handbook to the LiBase receiver, click (Mobile Station), 
customize the add mode, click the (Add) button in the lower-left corner, 
select the host network or the handbook network for the data link, select 
CORS in the communication mode, enter the server name, domain name /IP 
address, and port. Click the ‘Get’ button on the far right of the source list to 
get the desired source list, enter the user name and password, save the 
mode, and start.

This mode needs to use the network, the SIM card is inserted in the LiBase 
receiver, and the data link selects the host network; when the SIM card is 
inserted in the handbook or the handbook is connected to WIFI, the hand-
book network is selected.

2.2.4 CORS Mode

Receiver Connection and Mode Settings 02
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04Functional Usage
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4.2 Point Survey
(Survey)→(Point Survey) interface, modify the rod height to be consis-
tent with the actual one, and the bubble can be centered to measure.

1

If you want to perform tilt measurement, click the tilt icon on the (point 
survey) interface to enable the tilt measurement function. At this time, it 
will prompt the tilt measurement initialization. Follow the instructions 
on the handbook interface to initialize. After the prompt is completed, 
the tilt icon will change from red to green. Inclination measurement can 
be performed.

2

After the measurement, 
the data will be auto-
matically saved in the 
coordinate point library.

3

the accuracy meets the 
requirements. If automat-
ic pairing is selected, the 
GNSS point name mea-
sured on the control point 
needs to be saved the 
same as the control point 
name. After the parameter 
calculation is completed, 
the job can be performed.

When there are only two control points, it is necessary to simply evalu-
ate the correctness of the coordinates of the control points through the 
scale factor (0.9999 < scale factor < 1.0001) .

The parameter calculation operation is as follows:

Input control point coordinates: (Project) →(Coordinate Point 
Library) → click “+” in the lower right corner→(Type in) → point 
name, code (optional), check control point for attribute type, and 
coordinate type as local plane coordinates → Enter the coordinates 
of the three control points in sequence → OK. After the coordinates 
are input, a detailed check must be done to avoid input errors and 
subsequent conversion problems.

①

② 

③ (

Collect the coordinates of the control point: on the (Survey) → (Point 
Survey) interface, click the button to collect the coordinates to 
collect the coordinates, and pay attention to keeping the rod height 
consistent with the actual one.

(Tools) → (Parameter Calculation), click Add in the lower right 
corner, select manual pairing, select the corresponding control point 
from the (Control Point) library (the known control point entered in 
the point library before) or directly input, (GNSS Point). Select the 
point measured on the known control point from the library, select 
the horizontal and vertical for the (Correction method), and add the 
control point data cyclically according to this method. Click (Set-
tings), and the coordinate conversion method can choose plane 
correction + elevation fitting, seven parameters or seven parameters 
+ plane correction + elevation fitting. Elevation fitting method is 
selected automatically, (OK). Click (Calculate) to view the horizontal 
residual (the residual should be within 2 cm), and click (Apply) after 

2
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4.4 CAD Stake

4.5 Curve Stake
(Survey) → (Curve), enter the curve library, click "+" in the lower right corner 
to add, enter the curve design interface, select the line type, and enter the 
curve name and related parameters. Taking the one-point method as an 
example, input the starting point mileage, input or measure the starting 
point coordinates, input the azimuth, line length, radius, and deflection, 
and click OK to set out.

(Survey) → (CAD Stake), click "Import Drawing" at the bottom of the screen 
to select the desired CAD drawing, the file type is dxf or dwg format. After 
opening the diagram, click the point selection staking symbol in the upper 
right corner, select a point to be staked in the diagram, and the coordinate 
information of the point will pop up. After clicking OK, the point can be 
staked. Select a line in the figure, click the stakeout setting in the lower right 
corner to set the starting point mileage of the line and the offset distance, 
calculation method, and interval of stake-by-pile coordinate stakeout. After 
clicking stakeout, you can stake out the line.

4.3 Stakeout
(Survey) → (Point Stake), enter the coordinate point library, click the "..." in 
the lower right corner, you can choose to add or import the coordinates of 
the stakeout point, then select the point you want to stake out, and click 
(Stakeout) to start stakeout.

If you need to modify the display method of the prompt data, you can click 
the setting button in the upper right corner to modify it. For example, the 
distance prompt can be east-west, north-south or front-back, left-right, and 
the elevation can be positive or negative or fill and dig.

Note:

Before initialization of tilt compensation, it is necessary to set the rod 
height value consistent with the actual value;

①

② During initialization, it is necessary to keep the bottom position of the 
centering rod unchanged during the front and rear shaking process;
Do not turn the instrument too fast when using tilt-compensated mea-
surement, otherwise it may need to be re-initialized.

04Functional Usage
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05LiBase Receiver Recalibration
Under normal operation modes, recalibration is required when these two 
situations occur:

Connect the LP1 handbook from GreenValley to the computer with the 
matching data cable, after the drop-down at the top of the handbook 
selects the "transfer file" method. The LP1 storage drive letter will appear on 
the computer interface. The measurement data path is GreenValley/ls/Ex-
port. The measurement task path is GreenValley/ls/Project.

he base station has been re-erected or the tripod has been moved artifi-
cially;

1

After setting the mobile station to the fixed solution state, enter (Base 
Station recalibration), collect a GNSS point at the control point through 
point measurement (i.e., collect coordinates at known control points), 
Then select (Known Point) (or input the known coordinates of the 
control point) → (Calculate) → (Apply).

After the operation is completed, other control points must be retested. 
The measured coordinates are consistent with the known coordinates, 
indicating that the base station is successfully calibrated, and the mea-
surement and stakeout work can be continued.

Base station receiver restart.2

06Data Transmission

4.6 Data Import
(Project) → (Data Import) → Select the file format and point type, and select 
the desired file according to the path (the selected file format must be 
consistent with the actual file).

4.7 Data Export
(Project) → (Data Export) → Select the exported data format, filter the 
exported point type and acquisition time, enter the file name, select the 
save path, and click OK. It can be exported in CSV, txt, and dat formats. To 
export detailed data information or other formats, you need to select a 
format from "More Formats" for data export.

15PAGE

04Functional Usage
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Common Faults and Disposing Method

Abnormal display on CDL external 
radio: 
E01 means the power supply voltage is 
too high;
E02 means the power supply voltage is 
too low;
E03 indicates that the configuration 
parameters are missing.

LiBase station receiver restarts 
repeatedly.

The differential light does not light up 
after the base station is started.

When working in network 1+1 mode, 
the "fixed" state of the mobile station 
is unstable.

Other anomalies whose cause cannot 
be determined

When the voltage is too low, it must be 
charged before use; 
When the parameters are lost, you can 
use the CRU software to reset them 
through the serial port.

The battery power is low, it can be used 
normally after charging. 

Check whether the host registration code 
has expired. If it has expired, please 
contact the distributor to apply for the 
registration code.

Check the local mobile phone signal 
strength, if the signal is not good, you 
can change to the built-in radio or exter-
nal radio mode to work.

Please contact one of the technicians of 
GreenValley for processing.

Fault Indication/Function
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06Data Transmission

07LiBase Receiver Registration

7.1 Expiration Reminder
If a permanent registration code for the receiver has not been entered or the 
temporary registration code has expired, when the Bluetooth connection to 
the receiver is successful, there will be a prompt message "RTK function 
expired". After the expiration date, the receiver will not be able to operate.

7.2 Contact Sales
Check the SN code of the RTK receiver device and contact sales.

7.3 Device Registration
Click [Device] → [Registration Information] → 
enter the registration code into the registra-
tion code box → click [Register] → restart the 
receiver and the registration is complete. You 
can also scan the QR code through this inter-
face to register.
The registration code is generally in the form 
of a string or a two-dimensional code. The 
string is a group of 10-digit characters, such as 
2259639206-2544851768-1170751387.
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Warranty Card

Commitment Warranty:
The main operating system of LiBase is guaranteed for 1 year, and the 
supporting accessories are guaranteed for 3 months.
In the event of replacement within the warranty period, the original product 
warranty period shall be followed.
For recalls due to product batch quality problems, the warranty period will 
be recalculated.
If the product requires paid repair or replacement services, the warranty 
period shall be recalculated for the repair/replacement part.

Disclaimer:
Improper use by the user, man-made damage, or unauthorized disassembly 
is not covered by the warranty.
Product failures caused by external forces such as environmental disasters 
are not covered by the warranty.

Environmental Tips:
After the product and accessories are invalid, please hand them over to a 
qualified waste recycling organization for disposal.


